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PCM5122/42EVM-U

The PCM5122/42 families of ICs are advanced segment, high-performance, software-programmable
stereo digital-to-analog converters (DACs). The PCM512x family employs fixed-function audio processing,
while the PCM514x family employs miniDSP audio processing. These devices employ internal line drivers
together with an internal PLL and BCLK reference, so that a serial clock signal (SCK) can be derived. The
advanced segment architecture enables excellent dynamic performance and an improved tolerance to
clock jitter, and the 2.1-VRMS ground-centered outputs eliminate the need for output dc blocking capacitors.
The PCM5122/42EVM-U is designed to support the PCM5121, PCM5122, PCM5141 and PCM5142
DACs. The PCM5122/42EVM-U also employs the TAS1020B USB controller and the SRC4392
asynchronous sample rate converter.

This User’s Guide describes the operation of the PCM5122/42EVM-U and the Texas Instruments
CodecControl software. CodecControl provides a graphical user interface for supported TI audio codecs.
The software is compatible with Microsoft® Windows® XP, Vista, and Windows 7.
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1 Introduction

CodecControl software is intended to facilitate user evaluation of TI audio codecs. It includes a wide range
of features, depending on the specific codec capabilities. The PCM5122/42EVM-U works together with the
CodecControl software. It connects to a PC via an available USB port and enumerates as a USB-class
audio device. Once configured with the CodecControl software, the EVM acts as a sound card that can
play back audio from the PC, depending on how the device is set up.

For a more detailed description of the PCM512x and PCM514x product line, refer to the product data
sheet available from the Texas Instruments web site at http://www.ti.com/.

Throughout this document, the abbreviation EVM and the term evaluation module are synonymous with
the PCM5122/42EVM-U. Unless otherwise noted, all references to the PCM5122/42 indicate complete
functionality of all four related devices (PCM5121, PCM5122, PCM5141 and PCM5142).

1.1 Information About Cautions and Warnings

This document contains caution statements.

CAUTION

This is an example of a caution statement. A caution statement describes a
situation that could potentially damage your software or equipment.

The information in a caution or a warning is provided for your protection. Please read each caution and
warning carefully.

1.2 Related Documentation from Texas Instruments

The following document provides information regarding TI's integrated circuits used in the assembly of the
PCM5122/42EVM-U. These documents are available from the TI web site. The last character of the
literature number corresponds to the document revision that is current at the time of the writing of this
document. Newer revisions are available from the TI web site at http://www.ti.com/.

Data Sheet Literature Number

PCM5122/42 SLAS759

TAS1020B SLES025A

SRC4392 SBFS029C

1.3 Applications Questions

If you have questions regarding either the use of this evaluation module or other TI evaluation modules,
post a question in the Audio Converters forum at http://e2e.ti.com. Include the product in which you are
interested in the subject heading.

1.4 FCC Warning

This equipment is intended for use in a laboratory test environment only. It generates, uses, and can
radiate radio frequency energy and has not been tested for compliance with the limits of computing
devices pursuant to subpart J of part 15 of FCC rules, which are designed to provide reasonable
protection against radio frequency interference. Operation of this equipment in other environments may
cause interference with radio communications, in which case the user at his own expense is required to
take whatever measures may be required to correct this interference.
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2 PCM5122/42EVM-U

2.1 Electrostatic Discharge Warning

Many of the components on the PCM5122/42EVM-U are susceptible to damage by electrostatic discharge
(ESD). Customers are advised to observe proper ESD handling precautions when unpacking and handling
the EVM, including the use of a grounded wrist strap at an approved ESD workstation.

CAUTION

Failure to observe ESD handling procedures may result in damage to EVM
components.

2.2 Overview

The PCM5122/42EVM-U is an easy to use, USB-interface, multi-functional system allowing for digital
optical/SPDIF, line or external I2S™ input with varying options for clock sources and clock frequencies.
Along with onboard sample rate conversion, this architecture allows for versatile use and testing of the
PCM5122/42 family of parts. Figure 1 shows the PCM5122/42EVM-U with the jumper and switch locations
noted.

(1) The silkscreen label shown on the board may be different to indicate a specific device. Otherwise, the EVM is
identical to the one shown here.

Figure 1. PCM5122/42EVM-U
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The PCM5122/42EVM-U is divided into two sections. The left half contains the digital and USB interface,
sample rate conversion, optical/SPDIF and RCA digital inputs, clock circuitry, and reset logic. The right
half contains the PCM5122/42 device and the analog circuitry accompanying it. Note that this half of the
PCM5122/42EVM-U is the portion required on a potential customer application. The left half is intended to
emulate a wide variety of testing options and scenarios for the PCM5122/42 device.

The digital interface section, or left half of the PCM5122/42EVM-U, is a four-layer design. However, the
PCM5122/42 device and analog circuitry, or right half of the EVM board, consists only of two layers.

For the analog circuitry surrounding the PCM5122/42 device, certain components can be removed at the
cost of higher performance. This configurability allows for optimal ratio between board space and
performance. Components such as C1, C3, C7, and C11 can all be removed for additional board space.

The PCM5122/42EVM-U features:

• USB Interface

• Analog output

• TX output (J5)

• Optical/SPDIF input

• I2S input

• Hardware- and software-programmable options

• Digital audio interface test points

• Control interface test points

• PurePath™ Studio Software Functionality

2.3 EVM Block Diagram

Figure 2 shows the block diagram for the PCM5122/42EVM-U.

Figure 2. PCM5122/42EVM-U Block Diagram
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2.4 Jumpers, Connectors, Test Points, Switches

Table 1 summarizes the connectors, test points, jumpers, and switches on the PCM5122/42EVM-U.

Table 1. PCM5122/42EVM-U Headers, Test Points, Jumpers, and Switches

Connectors/Switch/Jumper/Test Point Description

Headers

W1 I2C/SPI Selection. Shunt pins 1-2 for SPI, 2-3 for I2C control mode

W2 I2C/SPI Selection. Shunt pins 1-2 for SPI, 2-3 for I2C control mode

W3 Interface Connection. Shunt respective headers to send digital signals to
PCM5122/42.

W4 AVDD power. Shunt pins 1-2 or 3-4 for AVDD.

W5 MCLK/RXCKO select

Test Points

TP1 GPIO4/GPIO4/MAST

TP2 GPIO5/GPIO5/ATT0

TP3 MC/SCL/ATT1

TP4 MOSI/SDA/ATT2

TP5 GPIO3/GPIO3/AGNS

TP6 GPIO2/ADR2/DOUT

TP7 MODE1

TP8 MS/MODE2/MODE2

TP9 FLT

TP10 SCK

TP11 BCK

TP12 DIN

TP13 LRCK

TP14 FMT

TP15 XSMT

TP16 PCM5122/42 analog output (R)

TP17 PCM5122/42 analog output (L)

TP18 1.8 V

TP19 3.3 V

TP20 3.3 VA

TP21 GND

TP22 GND

TP23 GND

TP24 AGND

TP25 AGND

TP26 AGND

TP27 BCLK (TAS1020B)

TP28 WCLK (TAS1020B)

TP29 DIN (TAS1020B)

TP30 SCL (TAS1020B)

TP31 SDA(TAS1020B)

TP32 RESET

Jumpers

J1 PCM5122/42 RCA analog output (R)

J2 PCM5122/42 RCA analog output (L)

J3 Mini-USB connection

J4 Optical S/PDIF input
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Table 1. PCM5122/42EVM-U Headers, Test Points, Jumpers, and Switches (continued)

Connectors/Switch/Jumper/Test Point Description

J5 Coaxial S/PDIF input

J6 BNC external MCLK input

Switches

SW1 EVM reset

SW2 Select EVM application

SW3 MCLK select

LEDs

D2 RX lock

D3 SRC ready

2.5 Clock Circuitry

SW3 allows for MCLK selection from multiple sources. The PCM5122/42EVM-U contains an external BNC
jack, J6, as well as one programmed oscillator that provides a clock frequency of 24.576 MHz. The
TAS1020B also provides a MCLK output; by default, this clock is used as the master clock for the
PCM5122/42EVM-U. Depending on the application requirements, the SRC4392 is also able to derive a
received clock output (RCKO) output based on the input clock frequency, and this derived clock output
can be used as the MCLK input for the PCM5122/42 as well. This option is enabled by setting a shunt in
position 1-2 (RXCKO) on the 3-pin jumper W5. If W5 has a shunt in position 2-3, then setting SW3
determines which MCLK source is used, as summarized in Table 2.

Table 2. SW3 Clock Selection

Setting A B C

Onboard MCLK from TAS1020B Low Low Low

External MCLK 3.3-V BNC Input High Low Low

24.576-MHz MCLK from PLL Y3 High High High

2.5.1 MCLK Source Matching

The SRC4392 is equipped with two audio serial data ports, each of which generates BCLK and LRCLK
signals. When the SRC4392 receives an S/PDIF input, it automatically derives the MCLK of the input,
which is sent to the RXCKO pin. Dividers are used to send the generated BLCK and LRCLK from the
audio ports (if they are in master mode). For certain use cases, the SRC4392 is set up so that these ports
are used. When routing through the audio serial ports on the SRC4392, it is important to use RXCKO as
the master clock source for the PCM5122/42. In order to ensure proper operation, the master clock source
must be synchronized to the bit and word clock supplied to the PCM5122/42. Therefore, the master clock
source for the PCM5122/42 must also be replicated from the digital input source, which is why RXCKO
must be chosen. If the master clock source for the PCM5122/42 is the onboard MCLK from the TAS1020B
USB controller, for example, then there is potential for synchronization mismatch between the master
clock supplied to the PCM5122/42 and the bit and word clocks being supplied to the PCM5122/42. For
use cases routing through the SRC4392 audio serial ports, look to jumper W5 for selecting RXCKO as the
master clock source, as opposed to one of the options chosen by adjusting SW3. The SRC4392 product
data sheet has additional routing information.

The PCM5122/42 devices contain an internal PLL and BCLK reference, so that the MCLK can be
generated internally. When using external I2S input directly into the W3 jumper, a MCLK can be derived
form the BCLK input. Refer to the PCM5122/42 product data sheet for more details.
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2.6 Use Cases

2.6.1 PurePath Studios

The PCM512x and PCM514x are software programmable, and can be programmed using either
CodecControl software or PurePath Studio. For more information on enabling the audio processing
capabilities of the PCM512x with Pure Path, see the document below. This application note provides a
great starting point regarding the usage of PurePath with PCM512x and PCM514x devices. Note that
while the PCM512x employs fixed function audio processing, the PCM514x has full miniDSP processing,
enabling configurable process flows.

• PCM5122 with PurePath Application Note (SLAA541)

2.6.2 Scripts and Setup

Most of the I/O routing and clock frequency selection on the PCM5122/42 evaluation module is performed
by the SRC4392. Section 2.6.3 and Section 2.6.4 are two example scripts that adjust the SRC4392
registers accordingly, as well as set the proper jumper configurations.

There are several use cases where the PCM5122/42EVM-U can be used. Depending on whether it is
USB playback, or optical/SPDIF input, for example, there may need to be changes made in the scripts and
jumper configuration to accommodate these cases. Likewise, the shunts on header W3 may need to be
installed accordingly. Section 2.6.3 and Section 2.6.4 are some example use cases for the PCM5101 for
USB playback and optical/SPDIF input, respectively.

2.6.3 USB Playback
# The following script is used for playback via USB
# RESET RESET THIS IS MASTER RESET FOR SRC (48kHz)
# Page 0 = DEFAULT for Control
# Write to page 0
w E0 7F 00
# Register 01, Bit 7 = 1 resets to default
d 100
w E0 01 80
# Delay 0.1 sec to allow part to reset
d 100
# Register 01, Bit 7 = 0 for normal operation
w E0 01 00
d 100
# w E0 7F 00
# Register 01, Bit 7 = 1 resets to default

#----- Setup Port A ------#

# 24bit I2S, Master mode, DIR source, at mute
# Divide by 256, MCLK input source
# Unmute Port A Output
# power on port A and B
w E0 01 38
# set up port A as master, 24 bit I2S sourced from port B
w E0 03 19
# select MCLK as source at 256fs
w E0 04 01
# port B slave, 24 bit I2S
w E0 05 01

#----- Setup DIR ------#

#DIR Config 1
# Input source: RX2 - S/PDIF RCA (default)
#w E0 0D 01
# Input source: RX4 - S/PDIF optical, RX_MUX = RX1
w E0 0D 08
#DIR Config 2 - default
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w E0 0E 01

#----- Setup DIT -----#

# DIT COnfig 1
# Port A data in, DIv 256
w E0 07 80
# DIT Config 2
# Default is to output to RCA
# Comment out RCA and uncomment Optical for optical outputs
#Output to RCA
# TX - ON, TX MUTE - ON, Optical disabled
#w E0 08 06
# TX Mute - OFF
#w E0 08 04
#Output to Optical
# TX - OFF, TX MUTE - ON, optical disabled
w E0 08 03
# TX MUTE - OFF
w E0 08 01

#----- PLL Configuration -----#

# Set P=2, J=8, D=0
w E0 0F 22
w E0 10 1B
w E0 11 A3
# GPIO1 Config
# GPIO1 = RCVR non-audio data
w E0 1B 06
# GPIO2 Config
# GPIO2 = RCVR non-valid data
w E0 1C 07
# Power Status
# Disable RCVR (/PDRX) and Port B(/PDPB) power down and enable All Function power down
#w E0 01 14
#w E0 03 29

2.6.4 Optical/SPDIF Input via J4 (48 kHz, RXCKO Master Clock)
# RESET RESET THIS IS MASTER RESET FOR SRC
# SW3 (2-7) turned on, rest turned off
# Page 0 = DEFAULT for Control
# Write to page 0
w E0 7F 00
# Register 01, Bit 7 = 1 resets to default
d 100
w E0 01 80
# Delay 0.1 sec to allow part to reset
d 100
# Register 01, Bit 7 = 0 for normal operation

w E0 01 00
d 100
# w E0 7F 00
# Register 01, Bit 7 = 1 resets to default

#----- Setup Port A ------#

# 24bit I2S, Master mode, DIR source, at mute
# Divide by 256, MCLK input source
w E0 03 69
w E0 04 0B

#----- Setup DIR ------#
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#DIR Config 1
# Input source: RX2 - S/PDIF RCA (default)
#w E0 0D 01
# Input source: RX4 - S/PDIF optical, RX_MUX = RX1
w E0 0D 08
#DIR Config 2 - default
w E0 0E 01

#----- Setup DIT -----#

# DIT COnfig 1
# Port A data in, DIv 256
w E0 07 80
# DIT Config 2
# Default is to output to RCA
# Commment out RCA and uncomment Optical for optical outputs
#Output to RCA
# TX - ON, TX MUTE - ON, Optical disabled
#w E0 08 06
# TX Mute - OFF
#w E0 08 04
#Output to Optical
# TX - OFF, TX MUTE - ON, optical disabled
w E0 08 03
# TX MUTE - OFF
w E0 08 01

#----- PLL Configuration -----#

# Set P=2, J=8, D=0
w E0 0F 22
w E0 10 1B
w E0 11 A3

# GPIO1 Config
# GPIO1 = RCVR non-audio data
w E0 1B 06
# GPIO2 Config
# GPIO2 = RCVR non-valid data
w E0 1C 07

# Power Status
# Disable RCVR (/PDRX) and Port B(/PDPB) power down and enable All Function power down
#w E0 01 14

# Unmute Port A Output
w E0 03 29

# Disable All Function power down (all blocks set by local control)
w E0 01 3F

NOTE: For characteristic performance graphs, refer to the PCM5122/42 data sheet.
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3 CodecControl Software

This section explains how to use the CodecControl software together with the PCM5122/42 device. For
characteristic performance graphs, refer to the PCM5122/42 data sheet.

3.1 Control Software

The CodecControl software exposes most of the features of a supported TI audio codec EVM through an
intuitive graphical user interface.

NOTE: Before a PC running Windows can use the TI audio converter EVM as a sound card, the
EVM must be properly configured (sampling rate, audio routing, internal amplifier settings,
etc.) with the CodecControl software. This configuration occurs automatically once an EVM is
detected by the CodecControl software.

Figure 3 illustrates the CodecControl software with the PCM5122/42EVM-U window as an example of the
CodecControl software in operation.

Figure 3. EVM Software Window
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3.2 Installation

Download the CodecControl software from the PCM5122/42EVM-U audio codec product folder and launch
the program. The file is a self-extracting archive that is downloaded in a compressed format.

The default target folder is:
C:\Program Files\Texas Instruments\CodecControl

Click the Unzip button to complete the installation. The CodecControl software is now available in the
target folder. The name of the executable is CodecControl.exe.

To launch the CodecControl software, navigate to the target folder and double-click the CodecControl.exe
file.

3.3 Concepts

The CodecControl software presents a block diagram view of a supported TI audio codec EVM, such as
that shown in Figure 3.

The block diagram consists of active objects that respond to user input (for example, switches or
amplifiers with variable gain that show a volume control when a user clicks on the component with a
mouse).

NOTE: Active Objects: Each active object changes color to red if the cursor is placed over the
object. Clicking the object triggers its function.

Some active objects are linked to control register(s) of the particular TI audio codec. The CodecControl
software updates the appropriate register(s) whenever an active object is triggered. If a register that is
linked to an active object is changed through other components (for example, the script interpreter or the
register inspector), the active object changes its state accordingly.

The CodecControl software automatically detects a supported TI audio codec EVM once it is connected to
an available USB port of the PC.

If no TI audio codec EVM is connected to the PC, the control software also supports an EVM simulation
mode, where it is possible to retrieve script commands based on user input within the block diagram.

Simulation mode is only available if no TI audio codec EVM is attached to the PC. Choose File->New
EVM simulation… and select an EVM from the list of supported TI audio codec EVMs.

3.4 Dialogs and Active Objects

The CodecControl software contains several dialog windows that provide access to additional features.
Most dialogs are linked to active objects and are opened by clicking on the active object.

Several dialogs are not linked to active objects and are opened instead using the View menu.

3.4.1 Initialization Script Dialog

The CodecControl software executes an initialization script when a supported TI audio codec is detected.

To show or edit the initialization script, choose View->Init Script… from the main window menu bar.

Click the Run button to run the script again.
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3.4.2 Command Dialog

Open the command dialog (View->Command…) to write, edit, load, save, and run command scripts.
Command scripts are text files that contain commands to communicate with the TI audio codec. The
syntax is described in Section 3.5. The command dialog is shown in Figure 4.

Figure 4. Command Dialog

• The primary area of the command dialog is the command buffer (editable text) which contains the
command script. Clicking the Run button runs the command script.

• The smaller, read-only text area on the right side of the command dialog displays control data read
from the TI audio codec. The Clear button clears the Read Data field.

• The one-line text edit field on the left bottom allows single command execution.

• The Record check box enables recording of commands generated by the control software.
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3.4.3 Register Inspector

The register inspector dialog (View->Register Inspector…) gives access to all registers of the TI audio
codec. The register inspector displays the content of the connected TI audio codec device registers.
Clicking the Refresh button triggers reading the content of one page.

• The addr column shows the address of the registers in decimal notation.

• The description column contains a description for each register. If the register has no function
assigned, it is declared Reserved.

• The data columns show the data of each register (one byte). The first data column uses decimal
notation, and the second uses hexadecimal notation. It is possible to change the register value by
clicking into one of the data fields and typing the new value (either decimal or hexadecimal).

• The numbered columns show the register content in binary notation. Read/write bits are shown solid
black or red; read-only bits are gray or dark red. Red numbers represent bits that recently changed.
Change a single writable bit by clicking on the bit and it flips.

The coefficients may be used for a specific customer filter implementation. The format is compatible with
the TI audio codec that was detected by the CodecControl software.

NOTE: This feature is not used for the PCM5122/42, which are hardware programmable only.

3.4.4 Firmware Update

TI may publish new firmware for TI audio codec EVMs. Program the new firmware to a TI audio codec
EVM by choosing File->Update Firmware… and select the new firmware file.

The update process takes a few seconds (there is no progress bar) and is completed once the update
firmware dialog disappears. The EVM must be disconnected and reconnected to finish the firmware
update process.

3.5 Script Syntax

A script is a text file that contains data to send to a device.

Each line in a script file is one command. No provision is made for extending lines beyond one line, except
for the > command. A line is terminated by a carriage return.

The first character of a line is the command. Commands are:

r Read from the serial control bus
w Write to the serial control bus
> Extend repeated write commands
# Comment
I Set interface bus to use
b Break
d Delay
f Wait for Flag

Command: r <address> <register> <length>
<address> is the device address in hexadecimal format. For example, 30 for device address 0x30.
<register> is the register that is read from in hexadecimal format.
<length> is the number of bytes that are read from <register> in auto-increment mode.
The result is displayed in the right-side output window of the command interpreter dialog.

Command: w <address> <register> <data ...>
<address> is the device address in hexadecimal format. For example, 30 for device address 0x30.
<register> is the register that is written to in hexadecimal format.
<data…> is a sequence of bytes that are written to the <register> in auto-increment mode. Each byte
is in hexadecimal format.
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Command: > <data ...>
This command continues a write sequence in a new line.
<data…> is a sequence of bytes that is written in auto-increment mode. Each byte is in hexadecimal
format.

Command: # [optional comment]
This command indicates a comment.

Command: I<interface>
<interface> is i2c for I2C™ or spi for SPI.

Command: b[optional comment]
[optional comment] is a string of characters. The command interpreter shows a modal dialog with the
optional comment. Script execution resumes once the dialog is closed.

Command: d<time>
This command suspends script execution by at least <time> milliseconds.

Command: f <address> <register> <mask> [optional timeout]
This commands suspends script execution until the value read from <address> <register> matches
<mask>.
<address> is the device address in hexadecimal format. For example, 30 for device address 0x30.
<register> is the register that is read from in hexadecimal format.
<mask> is a 8-bit binary format mask that is compared with the data from the device. Each bit can be
0, 1, or X.
For example: <mask> = 010XX01X tests, if the data from the device has D7 = 0, D6 = 1, D5 = 0, D4 =
don’t care, D3 = don’t care, D2 = 0, D1 = 1, D0 = don’t care.
[optional timeout] specifies how long (milliseconds) the command interpreter polls the device if the data
do not match the <mask>.
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4 PCM5122/42EVM-U Schematic

Figure 5 shows the schematic for the PCM5122/42EVM-U.

Figure 5. Schematic
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5 Bill of Materials

Table 3 lists the bill of materials (BOM).

Table 3. PCM5122/42EVM-U Bill of Materials

KS CUST. QTY VALUE DESIGNATORS PKG/CASE T.COEFF/ TOL VOLT DESC. DIST. DIST P/N MFR. MFR. PART #
PART PART # PWR RATED

#

11360 C 2 2 2200 pF C12, C13 0603 C0G 5 50 V Capacitors Digi-Key 490-1459-2-ND Venkel C0603COG500-222JNE

11301 C 2/C 10/ 20 0.1 µF C15, C18, C20, 0603 X7R 10 50 V Capacitors Digi-Key 490-1519-2-ND Venkel C0603X7R500-104KNE
C22, C25, C28,
C30, C31, C32,
C33, C35, C36,
C37, C41, C43,
C44, C46, C47,
C48, C49

11068 C 1/C 10 1 1.0 µF C29 0603 X7R 10 16 V Capacitors Digi-Key 587-1241-2-ND TDK Corporation C1608X7R1C105K

11823 C 3 1 10000 pF C39 0603 X7R 5 50 V Capacitors Digi-Key 399-1092-2-ND Kemet C0603C103J5RACTU

11300 C 2 1 1000 pF C24 0603 C0G 5 50 V Capacitors Digi-Key 490-4768-2-ND Venkel C0603COG500-102JNE

11208 C 1/C 12 2 10 µF C34, C45 0603 X5R 20 6.3 V Capacitors Digi-Key 445-4112-2-ND Panasonic ECJ-1VB0J106M

11535 C 3 2 47 pF C26, C27 0603 C0G 5 50 V Capacitors Digi-Key 445-1277-2-ND Venkel C0603COG500-470JNE

11953 D 1 4 0.1 µF C2, C4, C6, C10 0805 X7R 10 100 V Capacitors Digi-Key 445-1418-2-ND Venkel C2012X7R2A104K

13777 D 3 1 100 pF C23 0805 C0G 5 50 V Capacitors Digi-Key PCC101CGTR-ND Panasonic ECJ-2VC1H101J
(NP0)

11013 D 6 4 10 µF C14, C16, C17, 0805 X5R 10 16 V Capacitors Digi-Key 587-1295-1-ND Taiyo Yuden EMK212BJ106KG-T
C19

11118 D 1/D 7 2 2.2 µF C8, C9 0805 X7R 10 25 V Capacitors Digi-Key 490-4787-2-ND Venkel C0805X7R250-225KNE

12360 D 2 3 22 µF C38, C40, C42 0805 X5R 20 6.3 V Capacitors Digi-Key 445-1422-2-ND Kemet C0805C226M9PACTU

20626 1 100 µF C21 P5 D10 H16 85°C 20 25 V Capacitors Nichicon UKZ1E101MPM

12689 P 4 1 10.0 kΩ C5 1206 1/4W 1 150 V Resistors Venkel CR1206-4W-49R9FT Venkel CR1206-4W-49R9FT

11493 P 2 1 0.0 (zero R7 1206 1/8W ±5% 250 V Resistors Digi-Key P0.0ETR-ND Venkel CR1206-8W-000T
Ω)

11464 N 5 1 1.50 kΩ R11 0603 1/10W 1 150 V Resistors Digi-Key 311-1.50KHRTR-ND Venkel CR0603-10W-1501FT

12011 P 2 5 10 Ω R18, R23, R25, 1206 1/4W 1 150 V Resistors Digi-Key P10.0FTR-ND Venkel CR1206-8W-10R0FT
R30, R31

12012 N 9 / N 38 8 10.0 kΩ R3, R4, R5, R16, 0603 1/10W 1 Resistors Digi-Key 311-10.0KHRTR-ND Venkel CR0603-10W-1002FT
R17, R20, R21,
R22

11528 N 5 2 470 Ω R1, R2 0603 1/10W 1 150 V Resistors Digi-Key 311-470HRTR-ND Yageo RC0603FR-07470RL

11127 N1/N38 2 100 kΩ R6, R14 0603 1/16W 1 Resistors Digi-Key 311-100KHRTR-ND Venkel CR0603-16W-1003FT

11541 N 6 2 2.70 kΩ R8, R9 0603 1/16W 1 150 V Resistors Digi-Key 311-2.70KHRTR-ND Venkel CR0603-16W-2701FT

12693 N 16 2 22.1 Ω R32, R33 0603 1/10W 1 75 V Resistors Digi-Key P22.1HTR-ND Venkel CR0603-10W-22R1FT

16884 N 31 2 27.4 Ω R12, R13 0603 1/16W 1 Resistors Digi-Key P27.4HTR-ND Panasonic - ECG ERJ-3EKF27R4V

11542 N 6 1 3.09 kΩ R10 0603 1/16W 1 150 V Resistors TTI RC0603FR-073K09L Venkel CR0603-16W-3091FT

11468 N 5 4 33.2 Ω R26, R27, R28, 0603 1/10W 1 50 V Resistors Digi-Key 311-33.2HRTR-ND Venkel CR0603-10W-33R2FT
R29

15084 N 26/N 42 1 4.70 kΩ R34 0603 1/10W 1 Resistors Digi-Key P4.70KHTR-ND Panasonic - ECG ERJ-3EKF4701V

11022 N 1 1 649 Ω R15 0603 1/10W 1 Resistors Digi-Key 311-649HRTR-ND Yageo America RC0603FR-07649RL
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Table 3. PCM5122/42EVM-U Bill of Materials (continued)
KS CUST. QTY VALUE DESIGNATORS PKG/CASE T.COEFF/ TOL VOLT DESC. DIST. DIST P/N MFR. MFR. PART #

PART PART # PWR RATED
#

11470 2 75 Ω R19, R24 0603 1/10W 1 150 V Resistors Digi-Key RMCF0603FT75R0TR-ND Venkel CR0603-10W-75R0FT

11522 2 LED - D2, D3 0805 2 V Optoelectronics Digi-Key 67-1553-2-ND Lumex Opto/Components SML-LXT0805GW-TR
Green Inc
Diffused

12333 1 LED - D1 0805 2.1 V Optoelectronics Digi-Key 67-1554-1-ND Lumex Opto/Components SML-LXT0805YW-TR
Yellow Inc

21439 1 SN74LVC U7 16-TSSOP 24 mA 1.65 V ~ 3.6 V Integrated Texas Instruments SN74LVC138APW
138APW Circuits

19081 1 PCM5142 U1 20-TSSOP Integrated Texas Instruments PCM5142PW
PW Circuits

21420 1 SRC4392I U12 48-TQFP Integrated Texas Instruments SRC4392I pFBR
pFBR Circuits

11992 1 TAS1020 U6 48-TQFP 3 V ~ 3.6 V Integrated Texas TAS1020B pFB Texas Instruments TAS1020B pFB
B pFB Circuits Instruments

11104 1 24FC512- U5 8-SOIC Integrated Digi-Key 24FC512-I/SM-ND Microchip 24FC512-I/SM
I/SM Circuits

13752 3 SN74LVC U8, U9, U11 SOT-23-5 32 mA 1.65 V ~ 5.5 V Integrated Digi-Key 296-11603-1-ND Texas Instruments SN74LVC1G125DBV
1G125DB Circuits
V

16878 1 TPS7361 U2 SOT-23-5 400 mA 1.8 V Integrated Texas TPS73618DBVT Texas Instruments TPS73618DBVT
8DBVT Circuits Instruments

17696 1 TPS7363 U3 SOT-23-5 400 mA 3.3 V Integrated Texas TPS73633DBVT Texas Instruments TPS73633DBVT
3DBVT Circuits Instruments

19633 1 SN74LVC U10 SOT-23-6 -40°C ~ 3232 1.65 V ~ 5.5 V Integrated Texas SN74LVC2G04DBVR Texas Instruments SN74LVC2G04DBV
2G04DBV 85°C Circuits Instruments

19685 1 TPS2553 U4 SOT-23-6 Adj Integrated Texas TPS2553DBVT Texas Instruments TPS2553DBV
DBV Circuits Instruments

14742 1 6 MHz Y1 4-SMD 2.5 mm 15 pF 50 3.3 V Crystals Mouser 788-8002AI133E-6.0T SiTime SIT8002AI-13-33E-6.00000T
× 2 mm

14380 1 22.5792 Y2 SMT 50 ppm 3.3 V Crystals Gscs SM7745HSV-22.5792M Pletronics SM7745HSV-22.5792M
MHz

14381 1 24.576 Y3 SMT 50 ppm 3.3 V Crystals Channel SM7745HSV-24.576M Pletronics SM7745HSV-24.576M
MHz Comp

15375 1 TORX147 J4 Fiber Optics Arrow TORX147PLF,T Toshiba TORX147PL(F,T)
PL(F,T) Electronics

11516 1 4 SPST SW3 4 pos 0.025 A 24 VDC Switches Digi-Key CKN9065-ND ITT Cannon - C K TDA04H0SB1R

13776 2 PB SPST- SW1, SW2 6.00 mm × 0.05 A 160 12 VDC Switches Digi-Key P13597SCT-ND Panasonic EVQ-PNF04M
NO Off- 3.50 mm
Mom

12926 3 Test Loop TP18, TP19, 0.040 Test Equipment Heilind 5000 Keystone Electronic 5000
- Red TP20 Electronics
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Table 3. PCM5122/42EVM-U Bill of Materials (continued)
KS CUST. QTY VALUE DESIGNATORS PKG/CASE T.COEFF/ TOL VOLT DESC. DIST. DIST P/N MFR. MFR. PART #

PART PART # PWR RATED
#

11048 23 Test Loop TP1, TP2, TP3, 0.040 Test Equipment Heilind 5002 Keystone Electronics 5002
- White TP4, TP5, TP6, Electronics

TP7, TP8, TP9,
TP10, TP11,
TP12, TP13,
TP14, TP15,
TP16, TP17,
TP27, TP28,
TP29, TP30,
TP31, TP32

14797 6 Test Loop TP21, TP22, 0.063 - Long Test Equipment Heilind 5011 Keystone Electronics 5011
- Black TP23, TP24, Loop Electronics

TP25, TP26

11087 3 1 × 3 W1, W2, W5 0.1 in High Connectors Samtec HTSW-150-07-G-S Samtec HTSW-150-07-G-S
Temp

11088 1 2 × 15 W3 0.1 × 0.1 in High Connectors Samtec HTSW-150-07-G-D Samtec HTSW-150-07-G-D
Temp

11088 1 2 × 2 W4 0.1 ×0.1 in High Connectors Samtec HTSW-150-07-G-D Samtec HTSW-150-07-G-D
Temp

11758 1 5227699- J6 BNC - 50 Ω Connectors Future 5227699-2 Tyco Electronics/Amp 5227699-2
2 Electronics

19083 1 Phono J5 T/H - R/A Connectors Digi-Key CP-1469-ND CUI Inc RCJ-047
Jack -
Orange

19085 1 Phono J1 T/H - R/A Connectors Digi-Key CP-1419-ND CUI Inc RCJ-042
Jack -
Red

19084 1 Phono J2 T/H - R/A Connectors Digi-Key CP-1420-ND CUI Inc RCJ-043
Jack -
White

14421 1 USB - J3 Type B ( SMT ) Connectors Heilind UX60-MB-5ST Hirose Electric Co Ltd UX60-MB-5ST
Mini B Electronics
type

14560 20 Shunt Note 0.1 in SP Hardware Mouser 151-8000-E Kobiconn 151-8000-E

11082 4 4-40/0.25 Screws Philips Hardware Pencom 4-40X1/4PH-PN-MS-SS Building Fasteners PMSSS 440 0025 PH
in -
Screws

11080 4 0.5 in Standoffs Round Hardware Pencom RST3/16-440X.5-A Keystone Electronics 2027
Threaded

DNI 4 DNI C1, C3, C7, C11 DNI DNI DNI DNI Undefined DNI DNI DNI DNI
Category
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EVALUATION BOARD/KIT/MODULE (EVM) ADDITIONAL TERMS

Texas Instruments (TI) provides the enclosed Evaluation Board/Kit/Module (EVM) under the following conditions:

The user assumes all responsibility and liability for proper and safe handling of the goods. Further, the user indemnifies TI from all claims
arising from the handling or use of the goods.

Should this evaluation board/kit not meet the specifications indicated in the User’s Guide, the board/kit may be returned within 30 days from
the date of delivery for a full refund. THE FOREGOING LIMITED WARRANTY IS THE EXCLUSIVE WARRANTY MADE BY SELLER TO
BUYER AND IS IN LIEU OF ALL OTHER WARRANTIES, EXPRESSED, IMPLIED, OR STATUTORY, INCLUDING ANY WARRANTY OF
MERCHANTABILITY OR FITNESS FOR ANY PARTICULAR PURPOSE. EXCEPT TO THE EXTENT OF THE INDEMNITY SET FORTH
ABOVE, NEITHER PARTY SHALL BE LIABLE TO THE OTHER FOR ANY INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL
DAMAGES.

Please read the User's Guide and, specifically, the Warnings and Restrictions notice in the User's Guide prior to handling the product. This
notice contains important safety information about temperatures and voltages. For additional information on TI's environmental and/or safety
programs, please visit www.ti.com/esh or contact TI.

No license is granted under any patent right or other intellectual property right of TI covering or relating to any machine, process, or
combination in which such TI products or services might be or are used. TI currently deals with a variety of customers for products, and
therefore our arrangement with the user is not exclusive. TI assumes no liability for applications assistance, customer product design,
software performance, or infringement of patents or services described herein.

REGULATORY COMPLIANCE INFORMATION

As noted in the EVM User’s Guide and/or EVM itself, this EVM and/or accompanying hardware may or may not be subject to the Federal
Communications Commission (FCC) and Industry Canada (IC) rules.

For EVMs not subject to the above rules, this evaluation board/kit/module is intended for use for ENGINEERING DEVELOPMENT,
DEMONSTRATION OR EVALUATION PURPOSES ONLY and is not considered by TI to be a finished end product fit for general consumer
use. It generates, uses, and can radiate radio frequency energy and has not been tested for compliance with the limits of computing
devices pursuant to part 15 of FCC or ICES-003 rules, which are designed to provide reasonable protection against radio frequency
interference. Operation of the equipment may cause interference with radio communications, in which case the user at his own expense will
be required to take whatever measures may be required to correct this interference.

General Statement for EVMs including a radio

User Power/Frequency Use Obligations: This radio is intended for development/professional use only in legally allocated frequency and
power limits. Any use of radio frequencies and/or power availability of this EVM and its development application(s) must comply with local
laws governing radio spectrum allocation and power limits for this evaluation module. It is the user’s sole responsibility to only operate this
radio in legally acceptable frequency space and within legally mandated power limitations. Any exceptions to this are strictly prohibited and
unauthorized by Texas Instruments unless user has obtained appropriate experimental/development licenses from local regulatory
authorities, which is responsibility of user including its acceptable authorization.

For EVMs annotated as FCC – FEDERAL COMMUNICATIONS COMMISSION Part 15 Compliant

Caution

This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may not cause
harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

Changes or modifications not expressly approved by the party responsible for compliance could void the user's authority to operate the
equipment.

FCC Interference Statement for Class A EVM devices

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to part 15 of the FCC Rules.
These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial
environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the
instruction manual, may cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to
cause harmful interference in which case the user will be required to correct the interference at his own expense.

http://www.ti.com/corp/docs/csr/environment/ESHPolicyandPrinciples.shtml


FCC Interference Statement for Class B EVM devices

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to part 15 of the FCC Rules.
These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment
generates, uses and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause
harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If
this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and
on, the user is encouraged to try to correct the interference by one or more of the following measures:

• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
• Consult the dealer or an experienced radio/TV technician for help.

For EVMs annotated as IC – INDUSTRY CANADA Compliant

This Class A or B digital apparatus complies with Canadian ICES-003.

Changes or modifications not expressly approved by the party responsible for compliance could void the user’s authority to operate the
equipment.

Concerning EVMs including radio transmitters

This device complies with Industry Canada licence-exempt RSS standard(s). Operation is subject to the following two conditions: (1) this
device may not cause interference, and (2) this device must accept any interference, including interference that may cause undesired
operation of the device.

Concerning EVMs including detachable antennas

Under Industry Canada regulations, this radio transmitter may only operate using an antenna of a type and maximum (or lesser) gain
approved for the transmitter by Industry Canada. To reduce potential radio interference to other users, the antenna type and its gain should
be so chosen that the equivalent isotropically radiated power (e.i.r.p.) is not more than that necessary for successful communication.

This radio transmitter has been approved by Industry Canada to operate with the antenna types listed in the user guide with the maximum
permissible gain and required antenna impedance for each antenna type indicated. Antenna types not included in this list, having a gain
greater than the maximum gain indicated for that type, are strictly prohibited for use with this device.

Cet appareil numérique de la classe A ou B est conforme à la norme NMB-003 du Canada.

Les changements ou les modifications pas expressément approuvés par la partie responsable de la conformité ont pu vider l’autorité de
l'utilisateur pour actionner l'équipement.

Concernant les EVMs avec appareils radio

Le présent appareil est conforme aux CNR d'Industrie Canada applicables aux appareils radio exempts de licence. L'exploitation est
autorisée aux deux conditions suivantes : (1) l'appareil ne doit pas produire de brouillage, et (2) l'utilisateur de l'appareil doit accepter tout
brouillage radioélectrique subi, même si le brouillage est susceptible d'en compromettre le fonctionnement.

Concernant les EVMs avec antennes détachables

Conformément à la réglementation d'Industrie Canada, le présent émetteur radio peut fonctionner avec une antenne d'un type et d'un gain
maximal (ou inférieur) approuvé pour l'émetteur par Industrie Canada. Dans le but de réduire les risques de brouillage radioélectrique à
l'intention des autres utilisateurs, il faut choisir le type d'antenne et son gain de sorte que la puissance isotrope rayonnée équivalente
(p.i.r.e.) ne dépasse pas l'intensité nécessaire à l'établissement d'une communication satisfaisante.

Le présent émetteur radio a été approuvé par Industrie Canada pour fonctionner avec les types d'antenne énumérés dans le manuel
d’usage et ayant un gain admissible maximal et l'impédance requise pour chaque type d'antenne. Les types d'antenne non inclus dans
cette liste, ou dont le gain est supérieur au gain maximal indiqué, sont strictement interdits pour l'exploitation de l'émetteur.
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【【Important Notice for Users of this Product in Japan】】
This development kit is NOT certified as Confirming to Technical Regulations of Radio Law of Japan

If you use this product in Japan, you are required by Radio Law of Japan to follow the instructions below with respect to this product:

1. Use this product in a shielded room or any other test facility as defined in the notification #173 issued by Ministry of Internal Affairs and
Communications on March 28, 2006, based on Sub-section 1.1 of Article 6 of the Ministry’s Rule for Enforcement of Radio Law of
Japan,

2. Use this product only after you obtained the license of Test Radio Station as provided in Radio Law of Japan with respect to this
product, or

3. Use of this product only after you obtained the Technical Regulations Conformity Certification as provided in Radio Law of Japan with
respect to this product. Also, please do not transfer this product, unless you give the same notice above to the transferee. Please note
that if you could not follow the instructions above, you will be subject to penalties of Radio Law of Japan.

Texas Instruments Japan Limited
(address) 24-1, Nishi-Shinjuku 6 chome, Shinjuku-ku, Tokyo, Japan

http://www.tij.co.jp

【ご使用にあたっての注】

本開発キットは技術基準適合証明を受けておりません。

本製品のご使用に際しては、電波法遵守のため、以下のいずれかの措置を取っていただく必要がありますのでご注意ください。
1. 電波法施行規則第6条第1項第1号に基づく平成18年3月28日総務省告示第173号で定められた電波暗室等の試験設備でご使用いただく。
2. 実験局の免許を取得後ご使用いただく。
3. 技術基準適合証明を取得後ご使用いただく。

なお、本製品は、上記の「ご使用にあたっての注意」を譲渡先、移転先に通知しない限り、譲渡、移転できないものとします。

　　　上記を遵守頂けない場合は、電波法の罰則が適用される可能性があることをご留意ください。

日本テキサス・インスツルメンツ株式会社
東京都新宿区西新宿６丁目２４番１号
西新宿三井ビル
http://www.tij.co.jp
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EVALUATION BOARD/KIT/MODULE (EVM)
WARNINGS, RESTRICTIONS AND DISCLAIMERS

For Feasibility Evaluation Only, in Laboratory/Development Environments. Unless otherwise indicated, this EVM is not a finished
electrical equipment and not intended for consumer use. It is intended solely for use for preliminary feasibility evaluation in
laboratory/development environments by technically qualified electronics experts who are familiar with the dangers and application risks
associated with handling electrical mechanical components, systems and subsystems. It should not be used as all or part of a finished end
product.

Your Sole Responsibility and Risk. You acknowledge, represent and agree that:

1. You have unique knowledge concerning Federal, State and local regulatory requirements (including but not limited to Food and Drug
Administration regulations, if applicable) which relate to your products and which relate to your use (and/or that of your employees,
affiliates, contractors or designees) of the EVM for evaluation, testing and other purposes.

2. You have full and exclusive responsibility to assure the safety and compliance of your products with all such laws and other applicable
regulatory requirements, and also to assure the safety of any activities to be conducted by you and/or your employees, affiliates,
contractors or designees, using the EVM. Further, you are responsible to assure that any interfaces (electronic and/or mechanical)
between the EVM and any human body are designed with suitable isolation and means to safely limit accessible leakage currents to
minimize the risk of electrical shock hazard.

3. You will employ reasonable safeguards to ensure that your use of the EVM will not result in any property damage, injury or death, even
if the EVM should fail to perform as described or expected.

4. You will take care of proper disposal and recycling of the EVM’s electronic components and packing materials.

Certain Instructions. It is important to operate this EVM within TI’s recommended specifications and environmental considerations per the
user guidelines. Exceeding the specified EVM ratings (including but not limited to input and output voltage, current, power, and
environmental ranges) may cause property damage, personal injury or death. If there are questions concerning these ratings please contact
a TI field representative prior to connecting interface electronics including input power and intended loads. Any loads applied outside of the
specified output range may result in unintended and/or inaccurate operation and/or possible permanent damage to the EVM and/or
interface electronics. Please consult the EVM User's Guide prior to connecting any load to the EVM output. If there is uncertainty as to the
load specification, please contact a TI field representative. During normal operation, some circuit components may have case temperatures
greater than 60°C as long as the input and output are maintained at a normal ambient operating temperature. These components include
but are not limited to linear regulators, switching transistors, pass transistors, and current sense resistors which can be identified using the
EVM schematic located in the EVM User's Guide. When placing measurement probes near these devices during normal operation, please
be aware that these devices may be very warm to the touch. As with all electronic evaluation tools, only qualified personnel knowledgeable
in electronic measurement and diagnostics normally found in development environments should use these EVMs.

Agreement to Defend, Indemnify and Hold Harmless. You agree to defend, indemnify and hold TI, its licensors and their representatives
harmless from and against any and all claims, damages, losses, expenses, costs and liabilities (collectively, "Claims") arising out of or in
connection with any use of the EVM that is not in accordance with the terms of the agreement. This obligation shall apply whether Claims
arise under law of tort or contract or any other legal theory, and even if the EVM fails to perform as described or expected.

Safety-Critical or Life-Critical Applications. If you intend to evaluate the components for possible use in safety critical applications (such
as life support) where a failure of the TI product would reasonably be expected to cause severe personal injury or death, such as devices
which are classified as FDA Class III or similar classification, then you must specifically notify TI of such intent and enter into a separate
Assurance and Indemnity Agreement.

Mailing Address: Texas Instruments, Post Office Box 655303, Dallas, Texas 75265
Copyright © 2012, Texas Instruments Incorporated



IMPORTANT NOTICE

Texas Instruments Incorporated and its subsidiaries (TI) reserve the right to make corrections, modifications, enhancements, improvements,
and other changes to its products and services at any time and to discontinue any product or service without notice. Customers should
obtain the latest relevant information before placing orders and should verify that such information is current and complete. All products are
sold subject to TI’s terms and conditions of sale supplied at the time of order acknowledgment.

TI warrants performance of its hardware products to the specifications applicable at the time of sale in accordance with TI’s standard
warranty. Testing and other quality control techniques are used to the extent TI deems necessary to support this warranty. Except where
mandated by government requirements, testing of all parameters of each product is not necessarily performed.

TI assumes no liability for applications assistance or customer product design. Customers are responsible for their products and
applications using TI components. To minimize the risks associated with customer products and applications, customers should provide
adequate design and operating safeguards.

TI does not warrant or represent that any license, either express or implied, is granted under any TI patent right, copyright, mask work right,
or other TI intellectual property right relating to any combination, machine, or process in which TI products or services are used. Information
published by TI regarding third-party products or services does not constitute a license from TI to use such products or services or a
warranty or endorsement thereof. Use of such information may require a license from a third party under the patents or other intellectual
property of the third party, or a license from TI under the patents or other intellectual property of TI.

Reproduction of TI information in TI data books or data sheets is permissible only if reproduction is without alteration and is accompanied
by all associated warranties, conditions, limitations, and notices. Reproduction of this information with alteration is an unfair and deceptive
business practice. TI is not responsible or liable for such altered documentation. Information of third parties may be subject to additional
restrictions.

Resale of TI products or services with statements different from or beyond the parameters stated by TI for that product or service voids all
express and any implied warranties for the associated TI product or service and is an unfair and deceptive business practice. TI is not
responsible or liable for any such statements.

TI products are not authorized for use in safety-critical applications (such as life support) where a failure of the TI product would reasonably
be expected to cause severe personal injury or death, unless officers of the parties have executed an agreement specifically governing
such use. Buyers represent that they have all necessary expertise in the safety and regulatory ramifications of their applications, and
acknowledge and agree that they are solely responsible for all legal, regulatory and safety-related requirements concerning their products
and any use of TI products in such safety-critical applications, notwithstanding any applications-related information or support that may be
provided by TI. Further, Buyers must fully indemnify TI and its representatives against any damages arising out of the use of TI products in
such safety-critical applications.

TI products are neither designed nor intended for use in military/aerospace applications or environments unless the TI products are
specifically designated by TI as military-grade or "enhanced plastic." Only products designated by TI as military-grade meet military
specifications. Buyers acknowledge and agree that any such use of TI products which TI has not designated as military-grade is solely at
the Buyer's risk, and that they are solely responsible for compliance with all legal and regulatory requirements in connection with such use.

TI products are neither designed nor intended for use in automotive applications or environments unless the specific TI products are
designated by TI as compliant with ISO/TS 16949 requirements. Buyers acknowledge and agree that, if they use any non-designated
products in automotive applications, TI will not be responsible for any failure to meet such requirements.

Following are URLs where you can obtain information on other Texas Instruments products and application solutions:

Products Applications

Audio www.ti.com/audio Automotive and Transportation www.ti.com/automotive

Amplifiers amplifier.ti.com Communications and Telecom www.ti.com/communications

Data Converters dataconverter.ti.com Computers and Peripherals www.ti.com/computers

DLP® Products www.dlp.com Consumer Electronics www.ti.com/consumer-apps

DSP dsp.ti.com Energy and Lighting www.ti.com/energy

Clocks and Timers www.ti.com/clocks Industrial www.ti.com/industrial

Interface interface.ti.com Medical www.ti.com/medical

Logic logic.ti.com Security www.ti.com/security

Power Mgmt power.ti.com Space, Avionics and Defense www.ti.com/space-avionics-defense

Microcontrollers microcontroller.ti.com Video and Imaging www.ti.com/video

RFID www.ti-rfid.com

OMAP Mobile Processors www.ti.com/omap

Wireless Connectivity www.ti.com/wirelessconnectivity

TI E2E Community Home Page e2e.ti.com

Mailing Address: Texas Instruments, Post Office Box 655303, Dallas, Texas 75265
Copyright © 2012, Texas Instruments Incorporated

http://www.ti.com/audio
http://www.ti.com/automotive
http://amplifier.ti.com
http://www.ti.com/communications
http://dataconverter.ti.com
http://www.ti.com/computers
http://www.dlp.com
http://www.ti.com/consumer-apps
http://dsp.ti.com
http://www.ti.com/energy
http://www.ti.com/clocks
http://www.ti.com/industrial
http://interface.ti.com
http://www.ti.com/medical
http://logic.ti.com
http://www.ti.com/security
http://power.ti.com
http://www.ti.com/space-avionics-defense
http://microcontroller.ti.com
http://www.ti.com/video
http://www.ti-rfid.com
http://www.ti.com/omap
http://www.ti.com/wirelessconnectivity
http://e2e.ti.com

	PCM5122/42EVM-U
	1 Introduction
	1.1 Information About Cautions and Warnings
	1.2 Related Documentation from Texas Instruments
	1.3 Applications Questions
	1.4 FCC Warning

	2 PCM5122/42EVM-U
	2.1 Electrostatic Discharge Warning
	2.2 Overview
	2.3 EVM Block Diagram
	2.4 Jumpers, Connectors, Test Points, Switches
	2.5 Clock Circuitry
	2.5.1 MCLK Source Matching

	2.6 Use Cases
	2.6.1 PurePath Studios
	2.6.2 Scripts and Setup
	2.6.3 USB Playback
	2.6.4 Optical/SPDIF Input via J4 (48 kHz, RXCKO Master Clock)


	3 CodecControl Software
	3.1 Control Software
	3.2 Installation
	3.3 Concepts
	3.4 Dialogs and Active Objects
	3.4.1 Initialization Script Dialog
	3.4.2 Command Dialog
	3.4.3 Register Inspector
	3.4.4 Firmware Update

	3.5 Script Syntax

	4  PCM5122/42EVM-U Schematic
	5 Bill of Materials

	Important Notices

